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Graphical Abstract

Abstract
Chronic lung diseases such as pulmonary fibrosis, asthma, and chronic obstructive pulmonary

disease (COPD) can cause significant damage to the epithelial tissues of the lungs. Currently, no existing
scaffolds accurately model the lung extracellular matrix (ECM) and its changes during cell injury from
inflammatory diseases. Specifically, no scaffold accurately models the change in mechanical stiffness
while also incorporating relevant biochemical cues. Hence, gelatin methacryloyl (GelMA) scaffolds with
variable stiffnesses that allow for co-culturing of lung epithelial cells and fibroblasts in transwell
air-liquid interfaces (ALIs) were created to model the epithelial-mesenchymal trophic unit for the study of
lung tissue inflammation. The scaffold’s mechanical properties were characterized as falling within
fibrotic and healthy ranges via rheometry. The scaffold’s biocompatibility was assessed through cell
viability and it was maintained over 85% for the course of one week in both groups, though it lowered at
the two week time point. The understanding of disease mechanisms gained from using this tissue model
would support translational research on developing treatments for inflammatory lung diseases.

1. Introduction
A multitude of chronic lung diseases such as pulmonary fibrosis, asthma, and chronic obstructive

pulmonary disease (COPD) can cause damage to epithelial tissues of the lungs. This tissue injury triggers



a fibrotic response in subepithelial fibroblasts that results in further fibrosis. According to the World
Health Organization, COPD was the 3rd leading cause of death globally in 2019 and over 120,000 people
die from COPD annually in the United States alone.1,2 While there are some treatments to alleviate
symptoms, such as bronchodilators and oral steroids, there is no cure for COPD1. An accurately mimetic
and tunable epithelial-mesenchymal trophic unit (EMTU) tissue model would allow for a greater
understanding of the effects of inflammatory diseases on lung epithelium. This knowledge has subsequent
applications in translational research, such as developing therapies that target disease-induced changes to
lung tissue.

The EMTU is a region of lung tissue composed of small-airway epithelial cells, subepithelial
fibroblasts, and the surrounding extracellular matrix (ECM) (Fig. 1).3 The ECM is a complex network of
proteins and other macromolecules that provides structural support as well as mechanical and biochemical
cues to surrounding cells.4 Cells can sense and react to their surrounding mechanical environment via
mechanotransduction at integrin adhesion sites.5 When chronic diseases cause epithelial injury, an
inflammatory response causes the fibroblasts to increase the production of ECM proteins such as
collagen, a fibrous structural protein, and fibronectin, a key binding protein.3 The interactions between the
fibroblast and the ECM are needed for the reconstruction of functional tissue; in lung diseases, this
remodeling can become abnormal.6

Fig. 1: The epithelial cells of the EMTU respond to inflammation by activating the subepithelial
fibroblasts, which causes them to produce more collagen. The increased collagen production increases
the stiffness of the lung ECM and creates a positive feedback loop; the higher stiffness causes additional

fibroblast activation.3

One result of this abnormal remodeling is an increase in the stiffness of fibrotic tissue in
comparison to healthy tissue. Typically, the healthy lung tissue has a Young’s modulus (E) in the range of
2-5 kPa, whereas fibrotic tissue is at least 3 times as stiff at ≥16.5 kPa.7 The development of pathogenesis
during injury or disease is not fully understood, and an in vitro model that accurately recapitulates the
tissue environment will allow for investigation of these mechanisms.

Due to the lack of effective treatments to reverse fibrosis, understanding the ECM’s influence on
cellular responses in a multitude of lung diseases has become a focus of therapeutic research studies.
Commonly, two-dimensional (2D) monolayer cell-culture systems are used to understand the mechanism
behind changes in cellular behavior in a diseased state, but these systems lack the complex cell-ECM



interactions of the lung microenvironment. This interaction plays an integral role in defining cell signaling
and function, thus the inability for 2D to mimic the biochemical and mechanical complexity of human
tissue can lead to inaccurate data.8 Furthermore, animal models do not accurately represent the
mechanisms of human disease.9 As a result, three-dimensional (3D) hydrogel models that mimic the
biochemical and mechanical microenvironment of the lung provide a more accurate in vitro system to
study the ECM’s influence on cell behavior in a diseased state.

Existing three-dimensional models of the human lung extracellular matrix have been utilized to
study the behavior and function of fibroblasts in various conditions. Marinkovic et al. developed a
hydrogel model composed of polyacrylamide (PA) at varying stiffnesses and growth factor conditions to
study fibroblast behavior.10 It was found that lung fibroblasts exert lower forces on softer matrices and
greater forces on stiffer matrices. Additionally, smooth muscle actin expression on stiffer matrices
suggested an interaction between stiff lung ECM and fibrotic mediators in fibroblast force generation.
Similarly, Liu et al. engineered a collagen I functionalized PA matrix system, again with a range of
stiffnesses.11 CCL-151 lung fibroblast morphology was analyzed, and significant differences were
observed. Lower stiffnesses corresponded to cells with rounded morphology, whereas stiffer gels gave
rise to spindle-shaped cells.5 Through these and other studies, it has been well established that lung ECM
has a bioactive role in physiological and pathological processes, such as the phenotype and function of
fibroblasts. In the case of chronic lung diseases and injury, these lung fibroblast interactions with the
ECM become abnormal and result in tissue remodeling. It has been demonstrated that hydrogel scaffolds
can be used to model the complex 3D bioactive environment of the lung ECM in the study of how these
conditions affect cellular behavior. Our scaffold will provide a tunable and individualized scaffold based
on the Dr. Brasiers research requirements that can be adapted as work progresses.

The aim of the current study is to develop a 3D bioprinted GelMA hydrogel as an in vitro model
to examine the influence of fibrotic mechanical properties on co-cultured lung fibroblasts and epithelial
cells. Characterization of the scaffold via rheology, biocompatibility, and cell viability was conducted to
determine the ability of the scaffold to accurately mimic the in vivo environment.

2. Materials and Methods
2.1. Cell Culture
MC3T3 cells were cultured using Dulbecco’s Minimum Essential Medium (DMEM)

supplemented with 10% fetal bovine serum (FBS) and 1% penicillin-streptomycin (pen-strep). Cells were
cultured in a 37 °C, 5% CO2, humidified incubator. The media was changed every 24 to 48 hours to
maintain cell viability and growth. Morphological assessments were performed regularly under a
microscope to monitor cell adherence and confluency. Subculture was conducted as needed to prevent
overgrowth. Before encapsulation within hydrogels, cells were passaged within 3 days at the most.

2.2. Preparation of GelMA Hydrogels
CELLINK BIO X™ 3D Bioprinter was provided by Dr. Allan Brasier to make the tissue model.

Variable UV crosslinking times of 2 seconds and 13 seconds were used to make the normal and fibrotic
tissue gels, respectively. The following settings remain consistent through all printing trials (refer to
Appendix A): cylindrical structure with 10 mm diameter and 2 mm thickness (2 layers), infill density of
52%, printer head speed of 6.5 mm/s, pre-flow delay of -200 ms, UV crosslinking once at the end rather
than between layers, UV crosslinking wavelength of 405 nm, and a UV crosslinking distance of 4 cm.
The scaffolds were printed from CELLINK GelMA bioink with lithium
phenyl-2,4,6-trimethylbenzoylphosphinate (LAP) 0.25% as a photoinitiator. A CELLINK



temperature-controlled printhead was used to warm the bioink to a printable consistency. To prevent the
bioink from cooling and clogging the nozzle while printing, a thermal insulator nozzle cover was added to
the temperature-controlled printhead.

2.3. Hydrogel Characterization
2.3.1. Rheometry

Rheometry testing was used to determine the mechanical properties of the hydrogels. This test
gave the storage modulus (G’) of the gels, which could be used to approximate the shear modulus (G*) at
very low frequencies (0.1 Hz). The Young’s modulus was calculated using the following equation: E =
2G*(1+ν), where ν is Poisson’s ratio. For hydrogels such as GelMA, ν can be assumed to be 0.5,
classifying them as an incompressible material that are deformed elastically at small strain percentages.12

The Young’s modulus can then be used to quantify varying stiffness values between the normal and
fibrotic stiffness hydrogels. The hydrogels were categorized based on their given stiffness values and if
they were accurately able to mimic their respective ECM environment.

The hydrogels were placed in a 37℃ incubator and swelled in DMEM for 24 hours before
testing. For this test, the Malvern Kinexus Ultra+ Rheometer was used, and a frequency sweep was
performed following the protocol in Appendix B. First, it was ensured that the bottom plate of the
rheometer was in the locked position by sliding the lever, located directly below the bottom plate, all the
way to the right. The next step was to open the rSpace application on the computer and select “Test 0035;
Frequency sweep, strain controlled” as the specific test required for this experiment. After this test was
selected, the user was then prompted to enter a gap value pertaining to the thickness (in mm) of the
hydrogel being tested. Before plugging this value in, the hydrogel was centered on the bottom parallel
plate. Only then was the gap value entered, after which the top parallel plate decreased the gap to this
thickness value. At this time, it was confirmed that the hydrogel remained centered and that the upper
parallel plate made contact with the top of the hydrogel without compressing the gel.

The next step involved entering the following testing parameters: temperature, start frequency,
end frequency, shear strain %, and samples per decade. In this specific test, the values were as follows:
Start Frequency = 0.1 Hz, End Frequency = 10 Hz, Room Temperature = 25℃, shear strain = 1%, and 10
samples per decade.13 After the testing parameters are entered, the test begins with a 5-minute calibration
before the frequency sweep. The frequency sweep occurs for approximately 10 minutes, and the results
are copied into an Excel spreadsheet. Next, a gap value larger than the thickness of the gel was entered, so
the hydrogel could be removed, and the next hydrogel could be tested. In between tests, it was ensured
that the upper and lower parallel plates were cleaned with 70% ethanol. Once all hydrogels were tested,
results were interpreted using Microsoft Excel.

2.3.2. Cell Viability of Encapsulated Fibroblasts
MC3T3s encapsulated in the hydrogels were labeled using a commercially available

LIVE/DEAD™ Cell Imaging Kit (ThermoFisher). A working concentration of .53 µM of calcein-AM
was used as the live stain, and a working concentration of 2 µM of ethidium homodimer-1 was the dead
stain. These concentrations were confirmed using the fluorescent dye concentration optimization protocol
(Appendix C). Hydrogels were washed 5 times with PBS for 5 minutes per wash at 37°C. Following the
washes, hydrogels were incubated with the live/dead stain for 15 minutes at room temperature. Care was
taken to minimize the dye exposure to light prior to imaging.

Imaging of the stained cells was performed using fluorescence microscopy (NIKON) using
multichannel FITC and RFP filters. The acquired images were then analyzed to quantify cell viability by
counting the number of live and dead cells in each field of view using a protocol for cell viability ImageJ



analysis (Appendix D). Bright-field and LIVE/DEAD images were taken on days 1, 3, 7, and 14 after
encapsulation.

3. Results
3.1. GelMA Hydrogel Stiffness Characterization
Two sets of hydrogel batches were successfully printed and tested following the rheometry

protocol. The first trial of gels - Group 1 - were printed with varying thicknesses but yielded similar
stiffness values at a 2 sec UV crosslinking time. Group 1 Young’s modulus values ranged from
4.242-5.286 kPa with an average of 4.82 ± 0.57 kPa. These values meet the design specifications for the
healthy tissue range. The second trial of gels - Group 2 - were printed with varying thicknesses and were
UV crosslinked for 13 seconds. The Young’s modulus of Group 2 was slightly more variable than Group
1 ranging from 14.743-21.891 kPa and had an average of 18.52 ± 3.60 kPa. These values obtained from
Group 2 meet the design specifications for the fibrotic tissue range. Group 1 and Group 2 results can be
seen below in Tables 1 and 2 respectively.

Sample Young’s Modulus (kPa) Size (Diam. x Thickness)

1 4.242 10mm x 1.55mm

2 4.737 10mm x 1.55mm

3 4.657 10mm x 1.60mm

4 5.286 10mm x 1.7mm

5 5.044 10mm x 1.8mm

Average ± S.D. 4.82 ± 0.57

Table 1: Group 1 (n=5) printing parameters and Young’s moduli measurements of
bioprinted GelMA hydrogels

Sample Young’s Modulus (kPa) Size (Diam. x Thickness)

1 14.743 10mm x2.3mm

2 18.927 10mm x 2.5mm

3 21.891 10mm x 2.5mm

Average ± S.D. 18.52 ± 3.60

Table 2: Group 2 (n=3) printing parameters and Young’s moduli measurements of
bioprinted GelMA hydrogels



3.2. Cell Viability of Encapsulated Fibroblasts
Cell viability was assessed as previously mentioned, with both bright-field images and

fluorescence images taken at 10x magnification. Fig. 2 shows some representative images; see Appendix
E for all fluorescence images of LIVE/DEAD staining.

Fig. 2: Representative bright-field and fluorescence images of cell-laden hydrogels. Bright-field images
show the morphology of the fibroblasts, while fluorescence images show

live and dead cells (live = green, dead = red).

At 1 day after encapsulation, the healthy stiffness hydrogels had an average cell viability of
91.7% while the fibrotic stiffness hydrogels had an average cell viability of 90.7%. Three days after
encapsulation, the healthy stiffness hydrogels had an average cell viability of 89.5% while the fibrotic
stiffness hydrogels had an average cell viability of 87.3%. After a week after encapsulation the fibroblasts
in the GelMA scaffolds, the healthy stiffness hydrogels had an average cell viability of 86.7% while the
fibrotic stiffness hydrogels had an average cell viability of 85.1%. There was a drop-off after 2 weeks,
with the healthy stiffness hydrogels having an average cell viability of 81.2% while the fibrotic stiffness
hydrogels only had an average cell viability of 63.6%. Table 3 summarizes the averages and standard
deviations obtained from cell viability analysis, while Fig. 3 represents the data graphically.

Table 3: The average % cell viability (and standard deviation) for each hydrogel stiffness condition was
calculated for each timepoint based on ImageJ analysis data

(day 1: n = 3, days 3-14: n = 5, see Appendix F).



Fig. 3: The above plot shows that while the % cell viability decreases over time for both stiffness
conditions, it still remains relatively high for the majority of the time course of the experiment.

(day 1: n = 3, days 3-14: n = 5, error bars denote ± standard deviation from the mean)

Over the 2 week time frame, differences in cell viability between healthy and fibrotic models
were statistically significant (P <0.05) on day 14. P-values, representing the probability that the observed
cell viability of fibrotic and healthy models could be obtained from the same population, are given below
in Table 4.

Table 4: P-Values for the difference between hydrogel stiffness conditions for each recorded timepoint.
P<0.05 denotes a statistically significant difference.

4. Conclusions
In an effort to address the need for a tissue model representative of the in vivo environment of the

epithelial tissue of the lungs in the study of its diseased state, a 3D cell culture model of the epithelial
mesenchymal trophic unit was developed as a research tool. The gelatin methacryloyl hydrogel scaffold
was fabricated using a bioprinting, which allowed for the necessary tunability for generating GelMA
scaffolds with low and high stiffnesses so that lung epithelial cells can be studied under normal and
fibrotic conditions, respectively.

Rheological mechanical testing confirmed that scaffold stiffness could be manipulated through
fabrication parameters, namely UV crosslinking time. A photocrosslinking time of 2 seconds yielded

Day P-Value

1 0.6126

3 0.4170

7 0.7187

14 0.0322



bioprinted GelMA hydrogels with stiffnesses within the desired 2-5 kPa healthy stiffness range, while a
photocrosslinking time of 13 seconds yielded bioprinted GelMA hydrogels with stiffnesses over the
desired 16.5 kPa fibrotic stiffness threshold.

LIVE/DEAD staining and subsequent fluorescence microscopy of cell-laden hydrogels confirmed
that 3D GelMA scaffolds can support the encapsulation of fibroblasts for an extended time in cell culture.
After 1 week, both healthy and fibrotic stiffness gels still had an encapsulated cell viability that was over
80%. Both conditions had similar viability up until the 2 week time point, at which the fibrotic stiffness
gels had a 20% drop in average % cell viability. This data shows that the GelMA hydrogel scaffolds can
support encapsulated fibroblasts. Additionally, bright-field microscopy of these hydrogels also confirmed
the fibroblasts maintained their normal spindly morphology while they are encapsulated; they do not
acquire a round morphology.

There are several potential next steps for this research in regard to future work. Firstly, the
hydrogel scaffolds can be further characterized by assessing their swelling and degradation. Swelling
ratios can be determined by comparing the weights of the gels when they are swelled to the weights when
they have been completely dried over the course of a week. Degradation can be assessed similarly by
measuring the weight of a hydrogel (with and without cells) at different time points to quantify mass loss
over time.

Importantly, human small airway epithelial cells (hSAECs) need to be seeded atop the scaffolds
to confirm that GelMA hydrogels can support epithelial cell culture. This can be assessed by quantifying
the adhesion area of the epithelial cells on top of the hydrogel through bright-field microscopy. As of now,
cell encapsulation has only been done with pipette-based hydrogels for proof of concept; fibroblasts must
be incorporated into bioink so the scaffolds can be printed already laden with cells. Once this process is
optimized, the final step would be to prove that bioprinted GelMA scaffolds can support a co-culture of
encapsulated fibroblasts and seeded hSAECs for an extended period of time.

In the future, this 3D, in vivo-mimicking lung ECM tissue model has applications in research
motivated by understanding how the diseased tissue state of chronic lung disease and injury affects the
small airway epithelium.
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Appendices
A. Protocol for Bioprinting GelMA Hydrogels

Below is the protocol followed for bioprinting GelMA hydrogels without cells:

1. Turn on the bioprinter and reduce lighting to 20% using the printer control options in the upper
right corner of the home screen. Click on “Select Protocol” and then select “cait10mmx1mm”.
Editing the protocol will allow the user to change settings for subsequent steps. This protocol
currently has the following settings:

○ Dimensions: Cylindrical structure with 10 mm diameter and 2 mm thickness (2 layers)
○ Infill density: 52%
○ Printer head speed: 6.5 mm/s
○ Pre-flow delay: -200 ms
○ UV crosslinking once at the end (rather than between layers)
○ Print surface: 6-well plate.
○ UV crosslinking wavelength: 405 nm
○ UV crosslinking distance: 4 cm

These print settings can be easily changed and saved in the protocol using the “edit protocol”
tools before beginning the print.

2. Remove GelMA cartridge from 4℃ fridge. Attach a 22G nozzle and the upper pressure hose to
the cartridge and place it in the temperature-controlled print head. Place the desired printing
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surface into the lower print bed. Most likely this will be a 6- or 12-well plate. Set the temperature
to 37˚C and let the GelMA heat up for 45 minutes.

3. Once the GelMA has heated up for 45 minutes, reduce the temperature to 26.1˚C (printing
temperature) and allow it to cool for 30 minutes.

4. Calibrate the printer. This can be done using the “move” option on the right side of the print
screen. The metal calibration probe must be put in the vertical position for bed-leveling, and the
printer door must be left open. Within the calibration menu, click “Automatic bed leveling” and
follow the instructions on the screen. Once this is done, push the metal probe back into its neutral
position and continue to “manual calibration” in the calibration menu. You will be prompted to
move the print nozzle to the front left well of the print surface. To properly calibrate the height:

○ Ensure that the screw of the print head that secures the cartridge is completely loose.
○ Adjust the height of the print head using the calibration controls until the nozzle makes

contact with the print surface. Increase the height of the print head until the nozzle is
mostly covered by the temperature-controlled print head. Leave ~1 mm of the nozzle
exposed to avoid GelMA residue buildup in the metal nozzle cover. Open the printer door
and tighten the screw to secure the position of the cartridge in the print head.

○ With a 22G nozzle, the printer bed height should now be set 400 microns below the
nozzle. If using a 27G nozzle, this distance should be 250 microns. Finalize the
calibration.

Note: After calibration, it can be useful to hit “print” followed promptly by “cancel print”. This
will leave the print head in an elevated position, which makes unclogging and test flow more
convenient before beginning the first print.

5. A test flow will now be performed to determine if the GelMA is ready to print. Navigate to the
pressure screen and hold a KimWipe underneath the print head nozzle.

○ Starting at 35 kPa, perform a test flow. The test flow button must be held continuously
throughout the test flow period. The filament coming out of the nozzle should appear
gel-like without a viscous appearance.

○ If the test flow has a low viscosity and appears to be liquid, the print temperature is too
high. Reduce the print temperature by 0.1-0.2˚C and wait for 10 minutes. If multiple test
flows at higher pressures are unsuccessful, the GelMA may be too viscous and the
temperature should be increased by 0.1-0.2˚C and 10 minutes should pass before doing
another test flow. Unclogging the nozzle between test flows and before beginning the
print is crucial.

○ If the filament curls around the tip of the nozzle to one side, the pressure is too low.
Increase pressure in increments of 2 kPa. Continue to test flow until the filament does not
curl around the nozzle. If the GelMA coming out of the nozzle expands around the tip in
all directions upon leaving the nozzle, the pressure is too high and should be reduced. On
average, successful prints happened within the range of 35-46 kPa.

○ Once the filament is gel-like and not curling around the nozzle, the user is ready to begin
the print. Be sure to unclog before checking to make sure the UV light time is set to either
fibrotic (13s) or normal (2s) range. Return to the printing screen.
Note: Sometimes adjusting the UV crosslinking time in the print does not actually change
how long the crosslinking occurs for. If this seems to be happening, exit the print and



re-enter the protocol menu from the beginning. Click “edit protocol” and adjust the UV
settings there before re-entering the print window.

6. Click on the “Print” button on the printing screen to begin the print.
7. The gels will print in the back 3 wells of the 6 well plate, and each gel will be subsequently

crosslinked after being printed.
8. Once the print is done (3 gels), rotate the 6 well plate 180˚ about the z-axis so that the other wells

can be printed in during the next printing trial.
9. Repeat step 5 to make sure the gel is still in the optimal printing range. Temperature and pressure

must continuously be monitored throughout the fabrication process.
10. Click the “Print” button again to run another printing trial.
11. Place gels in hSAEC growth media for 24 hours to swell.

B. Protocol for Rheometry Testing
Below is the protocol followed for mechanical testing of hydrogels with a rheometer:
Frequency Sweep Rheometry Protocol

1. Once GelMA hydrogels have been formed and allowed to set and swell for approximately 24
hours, rheometry testing may be performed.

2. Carefully remove 3-4 hydrogels of each type; healthy lung ECM and fibrotic lung ECM, keeping
the gels of the same type in their respective petri dish.

3. Once gels are in two separate weighing dishes, make your way over to the rheometer testing
machine (Malvern Rheometer - Kinexus Ultra+)

4. Make sure that the bottom plate is locked on the rheometer by pushing the level, located on the
front of the machine below the bottom parallel plate, all the way to the right

5. Open rSpace application on the computer and when prompted to select a certain test, select the
0035 test; Frequency Sweep Strain controlled.

6. When this specific test is selected, the user will then be prompted to enter a Gap value. This value
will pertain to the thickness (mm) of the hydrogel being tested. Center the hydrogel on the bottom
parallel plate. Measure the thickness (mm) of the hydrogel and enter the gap value. The upper
plate will then move to this gap value.

7. Once making sure that the upper plate makes contact with the top of the hydrogel and the
thickness is the correct value, enter values for various testing parameters such as room
temperature, start frequency, end frequency, shear strain %, and samples per decade. In this
specific test, the values were as follows: Start Frequency = 0.1 Hz, End Frequency = 10 Hz,
Room Temperature = 25℃, shear strain = 1%, and 10 samples per decade.

8. Once the various testing parameters are entered, the user will then be able to start the test. A
5-minute calibration will be performed before the actual test begins. Once this calibration has
been completed, the frequency sweep test will take approximately 10 minutes.

9. When the test is completed, the results table can be copied into an excel spreadsheet. Enter a gap
value that is greater than the thickness of the hydrogel to remove the hydrogel from the machine.
Clean upper and lower parallel plate surfaces with ethanol.

10. Repeat steps 5-9 for remaining hydrogels. In this specific test, 3-4 hydrogels of each type were
tested for a total of 6-8 separate frequency sweeps.

11. When testing is completed, results can be interpreted in Excel.



C. Protocol for LIVE/DEAD Staining
Below is the protocol followed for LIVE/DEAD staining of cells encapsulated in hydrogels:
Materials:

● 15mL conical tube
● 20μL pipette + tips
● 1000μL pipette + tips
● 10mL serological pipette
● Phosphate-buffered saline (PBS)
● Fluorescence microscope
● LIVE/DEAD Viability Kit (Thermofisher) containing calcein AM and ethidium homodimer-1

(EthD-1)
○ Store in a -20 ºC freezer protected from light

■ Either keep the reagent vials in a box or wrap them in foil
○ Before using the stock solutions, allow them to thaw to RT and centrifuge them briefly

before opening them
■ Fluorophores can aggregate overtime

○ Calcein AM hydrolyzes when exposed to moisture, so be sure to keep it away from water
(stock solution is in anhydrous DMSO)

○ Aqueous working solutions of calcein AM should be prepared immediately prior to use
and must be used within one day

○ Ethidium homodimer-1 is not sensitive to moisture; Aqueous working solutions of it can
be stored at -20 ºC for up to one year

○ Before refreezing stock solutions, seal all vials tightly

Fluorescent Dye Concentration Optimization:
1. Prepare samples of live and dead cells

a. Dead cells can be obtained by killing cells with 70% methanol for 30min
2. Use samples of dead cells to optimize the EthD-1 concentration

a. Dilute the EthD-1 in PBS to varying concentrations, add the dilutions to dead cells,
incubate for 30min, then image
i. Try diluting EthD-1 to 0.1 - 10μM

b. You want the lowest EthD-1 concentration which stains the dead cell nuclei bright red
with minimal cytoplasmic staining

3. Use a sample of dead cells to start to optimize the calcein AM concentration
a. Dilute the calcein AM in PBS to varying concentrations, add the dilutions to dead cells,

incubate for 30min, then image
i. Try diluting calcein AM to 0.1 - 10μM

b. You want the lowest calcein AM concentration which gives minimal cytoplasm staining
4. Use a sample of live cells to confirm the optimization of the calcein AM concentration

a. Dilute the calcein AM in PBS to the same concentration that used in the prior step, add it
to live cells, incubate for 30min, then image

b. See if the used concentration gives a sufficient green stain in live cells
i. If not, try a higher concentration on another sample of live cells



LIVE/DEAD Staining:
1. Use the serological pipette to add 10mL of PBS to the conical tube
2. Add enough calcein AM and ethidium homodimer-1 to the PBS to achieve the concentrations

determined in optimization process
a. Anecdotally, 20μL of EthD-1 and 5μL of calcein AM in 10mL of PBS gives

concentrations of 4μM and 2μM, respectively, and is suitable for 3T3 cells
b. Homogenize the staining solution by inverting the tube gently several times

3. Remove media from cell-laden hydrogels and wash with PBS
a. Do five 5min washes

i. Cover with aluminum foil and place in incubator during washes
4. Add 200μL of staining solution directly to the hydrogels
5. Cover with aluminum foil and let it incubate for 30 minutes at room temperature
6. Image the cells under a fluorescence microscope

a. Dim the lights in the working space and keep the gels covered whenever not imaging
b. Use the FITC/GFP filter for calcein-AM (live cells)
c. Use the TRITC/RFP filter for ethidium homodimer-1 (dead cells)

Tips:
● If you have extracellular fluorescence, do additional and/or longer washes with PBS prior to

staining because media can have esterases which hydrolyze the calcein AM to cause fluorescence
○ Calcein AM is calcein acetoxymethyl ester, and it functions by permeating live cell

plasma membranes and then getting hydrolyzed by intracellular esterases which releases
the fluorescent calcein

● Be sure to dim the lights of the work space and have cells covered in foil when not actively
adding something or imaging

○ The fluorescent dyes are photosensitive

D. Protocol for Cell Viability ImageJ Analysis
Below is the protocol followed for analyzing LIVE/DEAD images with the ImageJ software
Materials:

● Computer
● ImageJ software with Bio-Formats plugin package
● Fluorescent LIVE/DEAD staining images

Methods:
1. Capture a fluorescent image and save the file with both the green (live) and the red (dead)

channels
a. If a Nikon fluorescence microscope was used, the file will save as a .nd2

2. Open the file in ImageJ
a. File > Open > select the .nd2 file
b. In the Bio-Formats Import Options window, set “View stack with:” to “Hyperstack” and

“Color mode:” to “Default”
c. Click “OK”

3. Split the image such that each channel is its own image



a. Image > Color > Split Channels
b. Close the blue channel since only the green and red channels will be used

4. Change the images’ type
a. Image > Type > 8-bit

5. Eliminate some background noise by adjusting the brightness and contrast
a. Image > Adjust > Brightness/Contrast
b. A window will pop up with a pixel intensity histogram

i. Move the “Minimum” slider to the right until the image looks cleaner without
losing any important signal

ii. If necessary, move the “Maximum” slider to the left to increase the intensity of
the staining

iii. When done, click “Apply”
c. Repeat B/C adjustment for the other image
d. Keep B/C settings constant between different images of the same channel

i. All green images should have same settings and all red images should have same
settings, but green and red images don't have to have the same settings

6. Convert the gray-scaled images into binary images via Thresholding
a. Image > Adjust > Threshold

i. Make sure dropdown menus say “Default” and “Red” and that “Dark
background” is checked

b. Move the top slider (the left bound of the threshold) so that only the stained cells are
highlighted in red

c. Thresholding is a critical step
i. Too high of a threshold results in losing a lot of signal
ii. Too low of a threshold will fuse cells close to each other and include background

noise, making counting more difficult
d. Click “Apply” to get a binary thresholded image
e. Repeat thresholding for the other image

7. On both images, separate fused cells
a. Process > Binary > Watershed

8. Set up the measurements window
a. Analyze > Set Measurements
b. Make sure “Area” is checked
c. Click “OK”

9. Establish inclusion criteria for analysis
a. Analyze > Analyze Particles
b. Check “Add to Manager” and “Include holes”
c. Set “Size” to “0-Infinity” and “Circularity” to “0.00-1.00”
d. Click “OK”
e. With the ROI Manager open, click on a ROI that is the smallest but is still clearly a

stained cell, then click “Measure” in the window to get its area in μm2

f. Record this area, then click “Delete” to delete all ROIs from the manager
g. Repeat this process for the other image



i. Dead cells are smaller than live cells, so you cannot use the same minimum area
for both images

10. Obtain stained cell counts for each image
a. Once again, go to Analyze > Analyze Particles
b. Check “Summarize” and “Include holes”
c. Set “Circularity” to “0.00-1.00”
d. Set “Size” such that the minimum is slightly smaller than the area that was recorded from

the previous step and the maximum is “Infinity”
e. Click “OK”
f. In the Summary window that pops up, record the value in the “Count” column

i. This is the number of stained cells for that particular channel
g. Repeat this process for the other image

11. Calculate the percentage of live cells to obtain cell viability
a. % Live = (Countgreen / (Countgreen + Countred)) * 100

i. Countgreen = number of live cells stained with calcein AM in the green channel
ii. Countred = number of dead cells stained with ethidium homodimer-1 in the red

channel

E. Cell Viability Images
Below are the fluorescence microscopy images taken after LIVE/DEAD staining

Healthy Stiffness Gel 1 (10x) Day 1:

Healthy Stiffness Gel 2 (10x) Day 1:



Healthy Stiffness Gel 3 (10x) Day 1:

Fibrotic Stiffness Gel 1 (10x) Day 1:

Fibrotic Stiffness Gel 2 (10x) Day 1:



Fibrotic Stiffness Gel 3 (10x) Day 1:

Healthy Stiffness Gel 1 (10x) Day 3:

Healthy Stiffness Gel 2 (10x) Day 3:



Healthy Stiffness Gel 3 (10x) Day 3:

Healthy Stiffness Gel 4 (10x) Day 3:

Healthy Stiffness Gel 5 (10x) Day 3:



Fibrotic Stiffness Gel 1 (10x) Day 3:

Fibrotic Stiffness Gel 2 (10x) Day 3:

Fibrotic Stiffness Gel 3 (10x) Day 3:



Fibrotic Stiffness Gel 4 (10x) Day 3:

Fibrotic Stiffness Gel 5 (10x) Day 3:

Healthy Stiffness Gel 1 (10x) Day 7:



Healthy Stiffness Gel 2 (10x) Day 7:

Healthy Stiffness Gel 3 (10x) Day 7:

Healthy Stiffness Gel 4 (10x) Day 7:



Healthy Stiffness Gel 5 (10x) Day 7:

Fibrotic Stiffness Gel 1 (10x) Day 7:

Fibrotic Stiffness Gel 2 (10x) Day 7:



Fibrotic Stiffness Gel 3 (10x) Day 7:

Fibrotic Stiffness Gel 4 (10x) Day 7:

Fibrotic Stiffness Gel 5 (10x) Day 7:



Healthy Stiffness Gel 1 (10x) Day 14:

Healthy Stiffness Gel 2 (10x) Day 14:

Healthy Stiffness Gel 3 (10x) Day 14:



Healthy Stiffness Gel 4 (10x) Day 14:

Healthy Stiffness Gel 5 (10x) Day 14:

Fibrotic Stiffness Gel 1 (10x) Day 14:



Fibrotic Stiffness Gel 2 (10x) Day 14:

Fibrotic Stiffness Gel 3 (10x) Day 14:

Fibrotic Stiffness Gel 4 (10x) Day 14:

F. Cell Viability Raw Data
Below is the raw data from ImageJ analysis of LIVE/DEAD staining images



G. Materials and Expenses
Below is a table of materials and expenses the authors used for this project:



H. Product Design Specification
Below is the Product Design Specification the authors aimed to follow for this project:
Function:

Dr. Allan Brasier and his research team have a need for a 3D model of the small airway of the
lung that varies in extracellular matrix (ECM) thickness and composition. This tissue model will be
designed with fibroblasts that facilitate ECM production and effector cells during injury response. The
model will include an air-liquid interface (ALI) that allows for in vitro research of the small airway to
explore how the ECM, epithelium, and fibroblasts orchestrate reparations after damage. This model will
be produced as a bioprinted 3D scaffold that has mechanical and biochemical properties that will be
compatible with the lung epithelial cells used for experimentation. The ECM scaffold will allow for
cellular communication and function similar to that of an in vivo environment.

Client Requirements:
● The product should be amenable to analysis via various techniques such as microscopy and

should allow for the encapsulation of lung fibroblasts and cell culture of epithelial cells. Provide a
suitable microenvironment for cell-cell interactions and ECM remodeling, as well as enable
comprehensive analysis of changes in cell behavior.

● Model should include an air-liquid interface to reflect the polarization of the epithelium in the
presence of air.

● Scaffold should have tunable mechanical properties to reflect that of native ECM.
● Product needs to be capable of cell encapsulation and be cell adhesive.
● The product needs to provide an environment that allows for ECM remodeling by encapsulated

cells and/or cells coating the scaffold surface.
● The products must be replicable and fabricated using a Cellink bioprinter.

Design Requirements:
1. Physical and Operational Characteristics
a. Performance Requirements:

The tissue model will consist of a bioprinted scaffold, encapsulated fibroblasts, and seeded human
small airway epithelial cells (hSAECs). The scaffold must be able to function as a cell culture platform;
therefore, it must provide the proper biochemical and mechanical signals for cell growth and viability.
Additionally, the tissue model system must be sustained for as long as the client needs to run experiments
on the cultured cells which will take an estimated two weeks.

b. Safety:

The tissue model of the EMTU will include human small airway epithelial cells as well as
fibroblasts. Since human cells will be used, all cell culturing and scaffold seeding must be conducted in a
BSL-2 lab. When working with human cells, the concept of “Universal Precautions” is used to reduce the
risk of bloodborne pathogens. This concept states that all unfixed tissues and cells are assumed to be
infectious, which requires them to be handled using BSL-2 practices and procedures. Proper PPE must be
worn while handling the cells. Additionally, anyone who works with the cells must have completed



UW-Madison’s Biosafety Required Training, as well as any other additional training required by the
BSL-2 lab in use [1].

c. Accuracy and Reliability:

i. Mechanical Properties:
The scaffold will undergo testing to ensure it meets the mechanical properties necessary

to accurately represent the lung ECM. Measuring the Young’s modulus (E) quantifies the stiffness
of the hydrogel and can be used to determine whether the hydrogel will accurately mimic its
respective tissue properties. The scaffold must have a tunable Elastic modulus ranging from
3.5-16.5 kPa to reflect the environment that fibroblasts experience through healthy lung tissue to
fibrotic lung tissue. The scaffold will be considered mimetic of healthy lung ECM if the
mechanical properties are within 5% of the values of native tissue.

ii. Cell Adhesion and Viability:
The scaffold will have cell culture of hSAECs cultured upon it for ideally two weeks. To

allow for this, the scaffold must mimic the small airway ECM and allow for cell adhesion
necessary for proliferation. Beyond this, fibroblasts will then be encapsulated to make the model
further resemble the in vivo environment of the EMTU. Furthermore, the composition of the
scaffold along with the process involved in making the model must be replicable in order to build
confidence in the merit of results obtained from scaffold use. To ensure that the scaffold is
capable of providing an environment for viable cell adhesion, testing will be performed on the
initial sets of scaffolds. This will involve microscopic imaging of the cells to study their
attachment to the scaffold, as well as their shape and viability. The shape of the cell within the
scaffold can be compared to their shape in the native state to gain insight to their functioning
within the hydrogel. Additionally, cell viability will be monitored to ensure the success of the
hydrogel to support cell culture. The scaffold will be considered capable of providing an adequate
microenvironment if at least 80% of seeded cells are able to proliferate.

d. Life in Service:

The bioprinted tissue-model product will be able to be maintained for at least one month. During
this period, the product will continue to be compatible with and allow researchers time to implement
various microscopy techniques for in-depth analysis while facilitating the encapsulation and culture of
lung fibroblasts and epithelial cells within an ALI that encourages cell-cell interactions and ECM
remodeling. Importantly, the 3D tissue model will remain replicable, consistently fabricated using a
CELLINK bioprinter, following the client's technology requirement.

e. Operating Environment:

Once the 3D scaffold is assembled in sterile conditions, the testing will be performed in a cell
culture environment. The scaffold will be left to swell for at least 24 hours in DMEM incubating at 37℃
and the air inside will have a 5% CO2 concentration. Cell seeding will be conducted in a sterile
environment and will incubate at 37℃ and the air inside will have a 5% CO2 concentration.

f. Ergonomics:



A clear, concise protocol must be written so that bioprinting the scaffolds will be easily replicable
as to increase the efficiency of fabrication and make use of the product easy for the client.

g. Size:

The cylindrical scaffold will have a diameter of 9 mm and should be at least 10 microns thick to
allow for the embedding of fibroblasts into the scaffold. The cells will then be cultured in a 12-well or
24-well plate with diameter of 22.4 mm [4].

h. Materials:

The tissue scaffold must support three main criteria. First, it must be able to produce a variable
range of stiffnesses, as described in the mechanical properties section (1.c.i). The material must also be
conducive to cell adhesion, contain RGD peptides to allow for integrin binding. The material must also be
conducive to matrix remodeling, containing motifs which are sensitive to matrix metalloproteinases.

The hydrogel will be fabricated from Gelatin Methacrylate (GelMA). Work completed in the
previous semester has demonstrated GelMA is capable of spanning a range of stiffnesses, mimicking the
mechanical microenvironment of both healthy and fibrotic lung tissue. The team has access to a 3D
bioprinter from CELLINK, a company which also sells GelMA bioinks. The team will fabricate the tissue
model using CELLINK bioink such that we can be consistent with the recommendation of CELLINK for
effective prints.

i. Aesthetics, Appearance, and Finish:

The scaffold should have an overall appearance that resembles the small airway ECM.
Additionally, the scaffold must be translucent for optical clarity – the scaffold will be imaged in order to
visualize the cell culture. As it is intended to accurately model the stiffness and composition of the ECM,
the main focus of the scaffold will be for the tensile strength to be similar to in vivo environments as well
as allowing for the incorporation of fibronectin and collagen to mimic a natural state. These functional
properties take priority over the aesthetic aspects of the design. This will allow for the epithelial cells to
attach to the scaffold with a normal morphology in order to create a realistic model of the EMTU.

2. Production Characteristics
a. Quantity:

Models of both healthy and fibrotic lung tissue are desired, so scaffolds with mechanical
properties matching the aforementioned conditions must be fabricated. Therefore, at least 6 scaffolds are
needed, three of each condition, for the purpose of replicability and statistical analysis.

b. Target Product Cost:

The materials for the scaffold should cost no more than $500. In the prior semesters, the team
used $1091 of the $5000 budget, so there is $3909 left to spend. The new scaffold design will be made
using the client’s bioprinter, so the only cost should be the GelMA bioink cartridges.

3. Miscellaneous
a. Standards and Specifications:



FDA approval is required for synthetic 3D scaffolds when they are brought to market. The standards and
regulations for these products are governed by ASTM F2150-19: Standard Guide for Characterization and
Testing of Biomaterial Scaffolds Used in Regenerative Medicine and Tissue-Engineered Medical Products
[5]. However, the FDA does not have specific standards or specifications for the use of 3D synthetic
scaffolds to study epithelial-mesenchymal transition (EMTU). Therefore, proper protocols for
biocompatibility, sterilization, and labeling must still be followed. The standards and regulations for the
use of bioinks and extrusion-based bioprinting are still under development, but there are some relevant
standards that are currently being developed, such as ASTMWK72274: New Test Method for Printability
of Bioinks for Extrusion-based Bioprinting and ASTMWK65681: New Guide for Bioinks and
biomaterial inks used in bioprinting.[6] These standards do not yet provide specific guidance on logistics
or compliance criteria. Additionally, there are many FDA requirements surrounding the use of cell and
tissue culture products, which are outlined in Standard 21CFR864 [7]. The purpose of these regulations is
to ensure that all research is conducted ethically and with appropriate oversight.

b. Customer:

The client has recently purchased a 3D bioprinter from CELLINK, intended for the team's
development of the tissue model. As such, the client would like us to make use of the bioprinter. The
client has also expressed a desire to use commercially available GelMA from CELLINK, rather than
GelMA synthesized and characterized by the team. This will make replication and fabrication much
simpler for the client once the team is no longer available.

c. Competition:

Tissue engineering models to provide in vitro means to study the body has in recent years created
many impressive novel designs. For models looking specifically at the lung epithelium, there are currently
both 2D and 3D models that mimic the in vivo environment. Unfortunately, these models are
oversimplified and do not provide accurate research results from experiments done on these models.

Looking into 2D models, these are typically layers of cells on top of polymer or glass dishes. In
the past several years, many experiments have been conducted on these 2D models, but while they have
allowed some study into cell function, disease, and the microenvironment, the models greatly lack the
typical native environment cell behavior. For reference, the 2D models have a stiffness range of 2-4 GPa
while the human lung ranges from .44-7.5 kPa [8]. The differences in stiffness significantly change the
behavior of the cells, and thus the experimental data found on them are reflective of in vivo behavior.

While there are many varieties of 3D models on the market, one of the most favorable is a
co-culture model using ECM protein gel (matrigel). These models are produced by embedding cells in
matrigel and culturing them directly on the surface [9]. These 3D models have variations in methods for
each experiment, but generally all involve an ECM gel 3D environment that is more similar (with some
limitations) to in vivo than the 2D models. Matrigel is a mouse tumor extracellular matrix mixture, so
there are variations for every batch and consists of proteins that don’t accurately represent healthy ECM.
Matrigel ECM is much similar to the ECM of a tumor with significantly more laminin glycoproteins,
which can cause the microenvironment to be unlike native tissue.



The gaps between these models and the in vivo environment result in a lack of data and findings
that accurately represent what is happening in the body. As a result, a bio-scaffold of the lung ECM is a
model that would bridge the gap between in vitro studies and in vivo actions at the cellular level.
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I. Prior Preliminary Designs
Below are descriptions of different hydrogel scaffold designs considered early in the project (As it is an
excerpt from prior work, citation numbers are without context):
Design 1: Gelatin Methacryloyl (GelMA)

GelMA is an engineered gelatin-based material that is produced through the reaction of gelatin
with methacrylic anhydride (MA). The addition of these MA groups allows for modified gelatin to be
photocrosslinked via UV light and a photoinitiator [8]. After GelMA is constructed the adhesive protein
motifs present within gelatin are retained. This motif is arginine-glycine-aspartic acid, or RGD, which is
an amino acid sequence naturally present in gelatin that allows for cell adhesion [8]. This adhesion is
beneficial because to mimic the ECM environment accurately there must be adhesion of the epithelial
cells being cultured to allow for proliferation. Additionally, matrix metalloproteinase (MMP)-sensitive
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sequences are also naturally found in gelatin. The sequences can be degraded by MMPs, which allows for
cell migration and reconstruction of the ECM by fibroblasts within the GelMA hydrogel. One downside
to GelMA is the mechanical variation between batches when using the same concentrations. When
GelMA is formed by functionalizing gelatin with MA, the degree of MA substitution varies batch to
batch. This results in hydrogels with differing properties when using the same concentration of GelMA,
but from different batches.

Design 2: Polyethylene Glycol (PEG)
PEG is a synthetic polymer that, when crosslinked, forms a hydrophilic and bio-inert hydrogel

that can be a scaffold for cell culturing. PEG is capable of having cells seeded within it by adding proteins
such as fibronectin and collagen or RGD peptide sequences to promote cell adhesion and degradation,
which this synthetic material does not naturally possess [7]. Young's modulus of PEG can fit within the
range of native healthy lung tissue or fibrotic tissue based on the percent concentration added to the
solution [7]. PEG was the design choice of the prior semester and the benefits and difficulties during that
semester are factored into the design matrix discussion.

Design 3: Lung ECM
Hydrogel scaffolds can be made from native lung ECM. The hydrogel is formed by

decellularizing lung tissue with several surfactants, freeze-drying the resulting ECM, solubilizing the
ECM with several proteolytic enzymes, and allowing the solution to gel [9]. This whole process requires
many materials and takes several days. While the main biological / biochemical properties of the lung
ECM are retained by the hydrogel, the mechanical / viscoelastic properties of native lung ECM are lost.
The hydrogel is cell adhesive and MMP-degradable, but it is less stiff and less viscoelastic than lung
ECM [9] Additionally, the mechanical properties, such as the elastic modulus, can not be tuned.

J. Prior Design Matrix
Below is a Design Matrix the authors used to guide early decision making for this project:

Design 1: Gelatin
Methacrylate
(GelMA)

Design 2: Polyethylene
Glycol (PEG)

Design 3: Lung ECM

Design
Criteria

Weight Score Weighted
Score

Score Weighted
Score

Score Weighted
Score

Mechanical
Properties

20 4/5 16 4/5 16 2/5 8

Biochemical
Properties

20 4/5 16 3/5 12 5/5 20

Ease of
Fabrication

15 4/5 12 2/5 6 1/5 3

Ease of Use 15 2/5 6 1/5 3 1/5 3

Mechanical 10 4/5 8 4/5 8 1/5 2



Design 1: Gelatin
Methacrylate
(GelMA)

Design 2: Polyethylene
Glycol (PEG)

Design 3: Lung ECM

Tunability

Biochemical
Tunability

10 3/5 6 4/5 8 1/5 2

Cost 10 5/5 10 3/5 6 1/5 2

Total: 100 74 59 40

Winner Tie

*A Gelatin Methacryloyl hydrogel won as the best choice with a total of 74/100, while a Polyethylene
Glycol hydrogel scored 59/100, and a Lung ECM derived hydrogel scored 40/100.

Explanation of Criteria

Biochemical properties are defined as the ability for the scaffold to mimic the biocompatibility,

porosity, adhesiveness, and cellular differentiation capabilities that are similar to the native lung

extracellular matrix (ECM). The suitability of any synthetic or semi-synthetic scaffold is based on the

properties found where it is intended to mimic. This means that the scaffold must be compatible with

collagen, fibronectin, and other cells that are found in the native lung environment. The porosity of the

scaffold is similar to that of native lung tissue which will allow for cellular communication or migration

of cells just as native ECM has properties that allow for cell adhesion to the ECM and further

communication.

Biochemical tunability is specifically how tunable the cell adhesive properties, porosity, and

degradation is for each gel. For synthetic hydrogels this tunability is dependent on the addition of peptides

or native cells while natural or synthetic hydrogels may already contain the necessary properties to

achieve the desired cell adhesion, degradability, and porosity.

The mechanical properties of the synthetic scaffold will need to reflect those of the native and

fibrotic lung environment. ECM changes in mechanical properties such as tension or stiffness can cause

major responses in cells which alter their ability to function properly. Due to the cells being sensitive to

the mechanical microenvironment around them the mechanical properties must accurately mimic those of

native tissue. Given that our client wants varying mechanical properties to model both native and fibrotic

lung tissues, the design should be able to produce hydrogels of elastic modulus from 2 kPa to 16.5 kPa

[1]. The viscoelastic properties for healthy lung tissue must include the storage modulus (G’= 500 Pa) and



loss modulus (G’’ = 50 Pa). Fibrotic lung tissue viscoelastic properties must also be met by the storage

modulus (G’ = 5 kPa) and loss modulus (G’’ = 500 Pa).

Mechanical tunability describes the ability of the material’s mechanical properties to be tuned

according to healthy lung tissue and fibrotic lung tissue modulus values. This can involve changing the

degree of crosslinking and concentration of material components.

Another criterion, ease of fabrication, is important when choosing a synthetic material due to the

wide range of methods when constructing the scaffold. The fabrication will need to be done in the BME

labs and the material must be accessible by students so that a model can be constructed in a timely

manner. Given that both the fabrication processes will result in variable properties, and an intention to

fabricate hydrogels of varying properties, the ability for the team to test mechanical and biochemical

properties of fabricated hydrogels will also be considered under this category.

Ease of use is weighted slightly lower but is still a vital component to the design process. This is

particularly important during the testing stages for cell cultures. Providing the scaffolds that can be

constructed in a mold and transferred to an Air Liquid Interface (ALI) is a necessary aspect of the design.

The ability for the client to create the designed hydrogels within his own lab also falls under the ease of

use. Additionally, in the context of the client's lab, the hydrogel must not interfere with cell culturing,

imaging, fibroblast incorporation, or any other assay performed.

Lastly, cost is a factor when determining the material to be used because it will need to be used

for multiple trials and cannot be out of the clients price range.

Justification of Scoring

PEG:

● Doesn’t have any adhesive or biochemical properties that promote desired cell functions or ECM

remodeling, this requires further purchasing of RGD peptides and MMP sequences [2].

○ While PEG can be created to have the biochemical specifications required, its tunability

requires much more fabrication with MMP sequences and RGD peptides. While PEG has

a wide range of biochemical properties that can be achieved, its process of achieving this

tunability is difficult resulting in a lower score for fabrication while tunability remains.

● PEG allows for very fine tuned mechanical properties due to the crosslinking chemistry

involved[2].

○ PEG allows for a wide range of mechanical properties to be achieved based on differing

molecular weight, arm length, and cross linking make it very tunable but the process of

this becomes challenging.



● The ability to crosslink during the fabrication process is very feasible with UV light being

available in the team labs but prior semester’s issues with the photoinitiator decreases the ease of

fabrication score.

● This also increases the cost because more I2959, a photoinitiator will need to be purchased

GelMA:

● Unlike PEG, GelMA is inherently biochemically active. Naturally occuring

arginine-glycine-aspartic acid (RGD) peptide sequences promote cell adhesion to the proposed

hydrogel [3]. Furthermore, GelMA’s structure contains matrix metalloproteinase (MMP) targeted

sequences, which allow for ECM remodeling following seeding of fibroblasts into the hydrogel

[3]. These amino acid motifs are not significantly affected during methacrylation or cross-linkage.

While a derivative of denatured collagen [4], GelMA experiences less antigenicity than collagen

based scaffolds [3] [4].

● The elastic modulus for GelMA is directly proportional to the degree of methacryloyl substitution

within the gel. As a result, the mechanical composition of the hydrogel can be altered to mimic

the elastic modulus of lung epithelium. Common MA substitutions for the synthesis of GelMA

result in elastic moduli of 2.0 ± 0.18 KPa (49.8%), 3.2 ± 0.18 KPa (63.8%), and 4.5 ± 0.33 KPa

(73.2%).[5] When gelatin is modified with the presence of methacryloyl groups and crosslinked

with UV light it gives rise to GelMa hydrogels that have great thermostability [6].

● The fabrication of GelMA is relatively simple as there is no need to incorporate peptide

sequences for adhesion or motifs sensitive to matrix metalloproteinases[3]. Fabrication consists of

solubilizing gelatin in PBS, methacrylation, and crosslinking via photopolymerization [7]. All

processes are capable of being performed in the BME labs.

● A GelMA hydrogel is fabricated in a mold and can be transferred into the clients ALI, or into

other culture flasks. Reproducibility of the hydrogel within the client’s lab contributed to a low

ease of use score given that there is a degree of batch to batch variability. Despite this, ease of use

was rated higher for GelMA than PEG or Lung ECM, as the fabrication process is easier.

● Without additional modifications, GelMA is drastically cheaper compared to PEG or Lung ECM,

with Gelatin powder available for $116/kg and Methacrylic anhydride available for $.56/ml. [8]

Lung ECM [9]:

● Hydrogels made from native lung ECM would have the best biochemical properties since the

natural peptide sequences/domains are present. However, some soluble factors would likely be

lost in the formation of the gel.

● Mechanical properties of the lung hydrogels are reduced with respect to the native lung ECM.

Stiffness is reduced and there is little mechanical tunability. Furthermore, the relaxation time after



compression is increased in the gels; the viscoelastic properties of the hydrogels and the native

ECM are different. Hydrogels made from Lung ECM also failed to accurately represent the

macromolecular structure of native lung tissue.

● The fabrication of the lung ECM hydrogel is a long process that involves processing lung tissue

with many surfactants and enzymes. The tissue needs to be decellularized and then enzymatically

solubilized, which takes days to do.

● Ease of use is ranked lower due to the difficulty for the client to reproduce and use this hydrogel.

● Cost of native tissue is very expensive and oftentimes rare to find. Native tissue is very sensitive

to exterior environments and many chemicals processes are needed to maintain the integrity of

the tissue
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K. Protocol for Pipette-Based GelMA Hydrogels
Below is the protocol followed for fabricating GelMA hydrogels with the pipette-based method:

1. Set water bath to 50℃
2. Measure out 50 mg of GelMA and place in 5ml sterile tube
3. Add 850µL of embedding media and place in water bath
4. While GelMA is dissolving, prepare a 20 million cells/ml stock solution
5. Sanitize molds with ethanol and UV light
6. Press silicone molds to a petri dish, making sure that the seal is tight to prevent polymer solution

from leaking
7. Get dissolved GelMA solution from water bath
8. Moving quickly to prevent temperature dependent gelation of the GelMA solution, add 50 µL of

LAP and 100 µL cell solution and mix well
9. Place 100 µL of solution into each 9mm silicone mold
10. Place gels in 4℃ fridge for 15 minutes
11. Place gels under UV light for 5 minutes
12. Place gels in 24 well plate with 400 µL of media

Protocol above will make ten 100 µL gels

L. Preliminary Pipette-Based GelMA Hydrogel Data
Below is preliminary rheological data and LIVE/DEAD staining data from the authors’ early work with
pipette-based hydrogels (includes excerpts from prior report explaining issues with the staining data):

Pipette-Based Hydrogels

Gel Batch Condition (4 °C, UV) Young’s Modulus (kPa)

Normal Batch 1 3 min, 5 min 4.2 ± 0.92

Normal Batch 2 5 min, 5 min 6.63 ± 2.6

Normal Batch 3 10 min, 5 min 13.24 ± 2.8

Fibrotic Batch 1 5 min, 7 min 49.65 ± 22

Fibrotic Batch 2 5 min, 10 min 277 ± 155



Table 1: Young’s modulus Data from pipette-based hydrogels with specified cooling and
crosslinking conditions

Observations of morphological signatures of fibroblasts such elongation, spindle-like morphology
were limited to the topmost and bottom most planes of the gels, as well as toward the sides of the gels.
See Table 2 for brightfield images of encapsulated fibroblasts

Table 2: Brightfield images of cell-encapsulated gels

Zoom Timepoint Image

10x

24 hours

48 hours

72 hours



Zoom Timepoint Image

20x

24 hours

48 hours

72 hours

LIVE/DEAD staining was inconclusive, as background noise during FITC imaging of calcein.
Images of gel planes at different depths were used to quantify the number of cells in a given plane as a
surrogate for cell density. Given the background noise, bright dots of in-focus calcein stain were identified
as cells, but as elaborated on under discussion, improper morphology leads to doubts about whether this is
a valid measure (see Table 3). Either by this quantitation, or by qualitative assessment, over all
timepoints, as gel stiffness increases, cell density increases.

Table 3: LIVE/DEAD staining of cell-encapsulated gels




